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Prescript...

AppleSauce this month

And so it’s 2012... Here’s the first issue of 
the year, with an item on switching from 

Word to Pages. They are sufficiently differ-
ent to require thinking about. Also in this 
issue are the regular features, a word, or term, 
of the month, Mike’s view from a currently 
colder clime, some Web links to explore, and 
so on.

During the holiday period a member wrote to 
a member of the committee saying that he’d 
found a collection of old AppleSauce from 
#1 and offering to scan them to PDF. Now this 
magazine and its preceding SAAUC Newslet-
ter have never been numbered, only dated, 
and the first issue with the current name was 
the October 1985 edition, so I don’t know 
which issue he’s referring to. (For the record, 
articles in the Oct 1985 magazine included 
‘Connecting a Koala Pad to a //e or //c’, ‘Book 
Review: Machine level programming on the 
II’, and ‘Apple //c Tips’.)

I suggested that instead the member write 
something new for this issue...

Apple’s recent announcement of iBooks Au-
thor has led to considerable comment. On the 
one hand, we have Michael E Cohen’s view: 
‘Why iBooks Author is a Big Deal’ at <tid-
bits.com/article/12739>, on the other, 
Glenn Fleishman’s, at Macworld.com:

Peter Carter MACS (Snr)

Apple seems to think that making the tool 
available solves the problem of pedagogy. 
Textbook makers and perhaps entre-
preneurs have been just waiting for the 
moment in which they could take all this 
media and stick it together. It’s as if Apple 
has forgotten interactive CD-ROMs, and 
isn’t aware of the current generation of 
textbooks as Web apps, easily available 
from any desktop or laptop computer in a 
school.

Steve McCabe, an experienced NZ educator 
has a similar opinion in ‘iBooks Textbooks: 
Not Exactly Innovation in Education’ at 
<tidbits.com/article/12740>.

As a former educator, I side with Fleishman 
and McCabe. In the mid 1990s I worked as an 
Authorware and Director programmer at The 
Orphanage Teachers’ Centre developing train-
ing materials. What Apple is suggesting with 
its proprietary extensions to the ePUB format 
is what we were doing then, but with a differ-
ent set of tools.

The other day someone was complaining on 
the Google Groups list that he couldn’t ac-
cess another club’s magazine on the Google 
site. This raises a number of questions. Why 
are we posting other clubs’ magazines on our 
site, instead of links to them? Why are they 

being put on the Google site instead 
of <www.saauc.org.au> where we 
have AppleSauce and other public infor-
mation? We gave up password access to that 
site some time ago simply because it made the 
site awkward to use.

When I left the SAAUC committee I continued 
to submit an editor’s report, now via email. 
You saw some of the kind of information that 
goes into them in the September issue. Not 
once has a report been acknowledged. Since I 

Alice to Ocean, an interactive 
multimedia text from the 1990s: 
what’s new?

http://tidbits.com/article/12739
http://tidbits.com/article/12739
http://tidbits.com/article/12740
http://www.saauc.org.au/
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AppleSauce this month

Frank Wade during his TV presentation at the 
December meeting

no longer see the minutes I don’t even know 
if my reports are tabled at meetings. Several 
times I have suggested that on occasions 
when the president was away another mem-
ber of the Club executive contribute. Then 
there is my longstanding request for brief 
reports of presentations and SIG groups, all 
to no avail.

So that you are aware of the situation, here 
are the final paragraphs of my most recent 
report:

December’s issue was another without 
any input from the president or other 
member of the committee, let alone the 
membership in general. It is as though 
SAAUC and AppleSauce were sepa-
rate entities, with all club communication 
through the Google list and site and not 
the long-established magazine.

The time has come for a decision. Without 
guaranteed support and input from the 
Club executive, AppleSauce will cease 
with the March 2012 issue.

This state of affairs is perhaps symptomatic 
of the Club in general, a state of decline with 
experienced members pulling out in frustra-
tion and noone prepared to step in. As I see 
it, we need a completely new Club executive: 
new president, vice-president, secretary and 
treasurer, all experienced and competent in 
computing matters and committed to rebuild-
ing the Club, along with more members on 
the committee.

The AGM is on the afternoon of Saturday 3 
March: it will be an important meeting.
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Presidential keyboard
Grant Ward

Welcome to 2012. Once again the new 
year brings us the Tour Down Under 

and the BUPA Community Challenge Ride 
which I participated in today (20 January) 
after enjoying last year’s event so much. I 
rode with someone else this year and because 
our pace was so evenly matched we were a 
motivation for each other and thus achieved a 
pace well ahead of what I was expecting. I’m 
already waiting for next year!

The Club had a successful year financially 
(as will be seen in the AGM documents that 
will be sent out very soon) with only a small 
deficit in the order of $100 (after considering 
an outstanding incoming payment) however 
our member participation/attendence, espe-

cially at the evening meetings continues to 
raise doubts over the viability of the Club long 
term.

Daytime meetings continue to be well attend-
ed but these are also highly dependent on the 
input of a few key people (Frank Wade and 
Peter Jenkins in particular). There have been 
a few other members step forward and help 
run a few sessions but it would be good to see 
more members do this.

I had a busy 2011 and have found it difficult 
to be involved enough in Club matters and 
have found it hard to reliably write some com-
ments for   each month (as you have probably 
noticed).

March will bring us to the Club 
AGM which will be held on the 
afternoon of the first Saturday in an attempt 
to allow more members to attend who aren’t 
able to attend evening meetings. Yet again I 
will be an apology for this meeting as it per-
fectly conflicts with the first race of the Clipsal 
500. Over the Christmas break I have decided 
that I need to step down from my position as 
President since I am unable to find the time 
required to fulfil the role to the level that is 
required. All of the current committee have 
been long serving and with a couple of us 
standing down, we will need to see some fresh 
blood come on board to fill the void. Please 
consider if you would be able to stand on the 
next committee.
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Defining...
Word of the month

Technical debt
We are familiar with the concept of finan-

cial debt: when we buy something ex-
pensive we can pay the entire amount at once 
(which may mean we forgo something else) or 
take out a loan and pay the debt, with interest, 
over time. Ultimately, the loan is more expen-
sive than paying the entire amount at once.

Technical debt, sometimes known as design 
debt, is a notion from computer program-
ming, although it has applications elsewhere. 
When a complex program is being written 
there may be the alternative of a ‘quick and 
dirty’ solution that meets the immediate 
needs, or a more complex, and therefore 
initially more expensive, solution that can be 
more easily expanded and maintained.

Take the initially cheaper option and eventu-
ally, when new features must be added, or 
bugs fixed, the work is more difficult, and 

expensive. The technical debt must be paid, 
with interest. One example was the Y2K prob-
lem. Programmers in past decades had used 
inappropriate date formats and end-of-file 
sentinels that would lead to errors once the 
date passed 1999. Untold hours were spent 
checking and correcting suspect code.

In extreme cases, the program becomes a ‘big 
ball of mud’: with so many bits added piece-
meal it has become an incoherent mess, with 
the only solution being to start over again. In 
effect, that’s what happened with the Mac’s 
operating system: fixing Mac OS 9 became 
too expensive so it was abandoned in place of 
the Unix-based OS X.

Few SAAUC members write code these days, 
so an example from word processing... A long 
document needs to be put together. It has a 
number of sections and subsections, with a 

hierarchy of headings, together with normal 
and indented paragraphs and the like.

Do it all with manual formatting, i.e. set the 
typeface, size and weight, margins, etc. sepa-
rately for each paragraph and you’ll finish 
up with a document that looks satisfactory at 
first glance.

You now find that a table of contents is re-
quired, listing headings and subheadings. To 
do this manually involves working through 
page by page, assembling the table line by 
line. Much easier to do it automatically, with 
the word processor searching for the appro-
priate heading styles and mapping them to 
the predefined table of contents styles.

Either spend the time setting things up at the 
beginning, or pay the technical debt when 
requirements change or problems need to be 
fixed. You will pay.
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How to...
‘In Word, you can use the menus and dialogs as training wheels...’

Strategies for switching from Word to Pages
Tonya Engst

Last year, when the Take Control ebook se-
ries migrated from Microsoft Word 2008 

to Pages ’09, I faced the challenge of not only 
acquainting myself with an unfamiliar piece 
of software, but also of helping a group of 
authors make the switch, all while under time 
pressure to keep up with Apple’s breathless 
product-release schedule. (If you are curious 
about why we chose to switch, or about our 
EPUB-savvy production process, see ‘How 
Take Control Makes EPUBs in Pages’: <tid-
bits.com/article/12472>.

Now that the commotion from the transition 
has died down, I want to share the strategies 
we used in switching from Word to Pages, 
along with some of my favorite Pages tips.

Look at the bottom
A classic mistake of the long-time Word user 
switching to another program is to assume 
that if you look long enough in the menus and 
dialogs, you’ll encounter all the important 
commands available (that’s even more true if 
you include Word’s Tools > Customize Key-
board dialog, which lists a wealth of obscure 
commands). In Word, you can use the menus 
and dialogs as training wheels and pretty 

soon you’ll start using keyboard shortcuts for 
commands that you choose often.

This approach failed dismally in Pages. In 
Pages, key functions are stuck hither and 
thither in the user interface and there is no 
apparent reference that lists them all.

Important options appear at the lower left of 
a Pages document, in a location that is pre-
cariously close to the Dock with a full-height 
Pages window and a horizontal Dock. I’ll 
explain the three options I use, but note that 
there is also a checkbox in the Pages General 
preference pane to show the word count in 
this lower area; I work with that turned off.

The leftmost pop-up menu lets you change 
your zoom level and how many pages are 
showing at once. Although Pages does have 

a Zoom command in the View menu, it won’t 
let you choose a specific zoom percentage and 
it lacks the pop-up menu’s One-Up and Two-
Up commands that control how many pages 
appear. I like to work at 100% with two pages 
showing, but many other Take Control folks 
prefer a higher zoom level in only a single 
page, so each time one of us opens the file, the 
zoom and display layout must be adjusted, 
which can be done only from this little pop-up 
menu.

The Pages area in the bottom window border 
turns out to be clickable. Click it, and a ‘Go 
to Page’ box appears where you can type the 
page number that you want to move to. Again, 
you can’t access this navigational control from 
any normal menu, dialog, or keyboard com-
mand.

http://tidbits.com/article/12472
http://tidbits.com/article/12472
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Strategies for switching from Word to Pages

commands to accept or reject changes whole-
sale, and it is useful for picking the color of 
your change-tracked text. (I have a great deal 
of fun monkeying with the colors; the second 
figure below shows Adam editing in purple 
and me editing in green; comments are al-
ways in yellow.)

To establish a comfortable workflow with the 
commands available only in the Track Chang-
es toolbar, I had to extend myself outside the 
confines of Pages because I needed keyboard 
shortcuts for some of its functions, particu-
larly for accepting changes and for toggling 
track changes on and off, both functions that 

I might invoke hundreds of times in a typical 
day. I finally turned to Keyboard Maestro to 
create macros that give me keyboard short-
cuts for those actions.

Inspect the Inspector
The Inspector is a panel that comes up if you 
choose View > Inspector (Command-Option-
I) or click the Inspector button on the tool-
bar. Many Pages options are available only 
from the Inspector, and the Inspector has a 
bank of tiny buttons at its top, which you click 
to switch between the different panes of op-
tions. I find working with the Inspector easy 
now, but for the first month it felt slow and 
cumbersome.

Frustratingly, each of the Inspector panes is 
a different size. I like to keep the Inspector 
open, for faster access, but it seems that as 
soon as I get it in the right spot on my screen, 
I switch panes and it becomes the wrong size 
for that spot. Some authors get around this by 
opening multiple copies of the Inspector with 
View > New Inspector. Personally, I wish the 
Inspector would open to one size and then 
lock onto an edge of the Pages window in a 

The Scroll To triangles and associated gear 
menu that appear next are incredibly valu-
able. You use the gear menu to set what the 
triangles do. For instance, they can advance 
you to the next comment in the document, or 
the next hyperlink. If you want to quickly flip 
through all the comments in a document, this 
is the only place to be.

Reveal hidden Track Changes 
toolbar
Another popular chunk of interface real 
estate for a group of people working on a 
document is the Track Changes toolbar (top 
of page), which you can bring up by choos-
ing Edit > Track Changes or by clicking the 
Track Changes button on the main toolbar. 
The Track Changes button isn’t present on the 
main toolbar by default, but you can custom-
ize the toolbar with View > Customize Tool-
bar or by Control-clicking it and choosing 
Customize Toolbar, just like in other Apple 
applications.

The Track Changes toolbar has two pop-
up menus on its right side that most Take 
Control people failed to spot on their first 
few rounds of writing or editing. The View 
Markup menu controls the extent of tracked 
changes that you can see, which is essential 
for hiding your tracked deletions (you might 
think you could hide them using the Deleted 
Text menu in Pages’ General preference pane, 
but you’d be wrong). The gear menu gives you 
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Strategies for switching from Word to Pages

neat way, as panels in InDesign do, since all 
too often I wind up with it in the way of some-
thing else. (Word has a similar problem with 
its Formatting Palette, but since most of its 
functions are available in other ways, you can 
keep it closed most of the time.)

Rummage around in the Styles 
drawer
Another exciting chunk of Pages real estate is 
the Styles drawer, which can be opened from 
the View menu, with a keyboard shortcut, 
from a button on the Format bar, or with a 
non-default toolbar button. Within the Styles 
drawer, it took me a while to realise that an 
accurate hover over the right of a style name 

would reveal a tiny triangle pop-up menu and 
it also took a while to be able to reliably click 
that minuscule menu on the first click. It all 
seems easy now, but at first it required persis-
tence.

Eventually, I made that menu open enough 
times and absorbed its capabilities to the 
point where I tried the Hot Key command, 
which lets you assign a function key (like 
F3, say) to a style, so that you can apply it by 
pressing a key on your keyboard. However, 
most of the Take Control crew already had 
our function keys assigned to other func-
tions. Third-party software again came to the 
rescue, this time in the form of AppleScripts 
for popular styles — each writer could install 
the scripts on his or her Mac and then use 
a macro utility (such as Keyboard Maestro 
or QuicKeys) to assign a keyboard shortcut 
to each script. In case you’d like to try this, 
here’s an example:

tell application “Pages”

  set mySel to (get selection 
of front document)

  set paragraph style of mySel 
to “Chapter Name”

end tell

(Chapter Name is the ‘Heading 1’ style that 
you must assign to your top level headings 
when exporting an EPUB from Pages.)

Although we read the manual and searched 
high and low in Pages, we’ve yet to find a 
way to configure a paragraph or list style by 
hand, by selecting the various attributes that 
we’d like it to include. This is sort of possible 
when creating (but not editing) a new char-
acter style by choosing Create New Character 
Style from Selection from the None charac-
ter style’s pop-up menu and then expanding 
the Include All Character Attributes control. 
But there is no equivalent to the technique in 
Word where you choose Format > Style, then 
click New or Modify. Instead, you must make 
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a paragraph or list look the way you want and 
then redefine the existing style. Wacky.

My kingdom for an outline!
A great feature in Word, and one that I am 
sorry to have left behind, is the Navigation bar, 
which has been given different names in dif-
ferent versions of Word, all while remaining 
functionally the same. You open it as a left-
hand bar in the Word window, and it shows 
the outline of your entire document, as long 
as you’ve used Word’s built-in heading styles 
(any experienced Word user would use those 
built-in styles — they are Word’s crown jewels 
with their elegant integration with the Table of 
Contents feature and full, useful Outline view).
In Word’s Navigation bar, you can see the 
‘forest’ surrounding the ‘trees’ of what you are 
reading at all times, and you can even edit the 
headings right in the Navigation bar. So, if you 
are in the middle of a chapter and deeply into a 
set of Heading 3 level topics, and suddenly the 
manuscript starts alternating between Head-
ing 2 and Heading 4 level topics, you know you 
are in trouble and can adjust immediately. You 
can also click any line in the Navigation bar to 
jump to the corresponding heading.
Alas, Pages has no such organisational naviga-
tion interface, Also, because Pages has neither 
a Back command after clicking a link nor any 
other sensible way to jump back and forth 
between two sections of a document, we are 
finding it challenging to get around in longer 
documents.

To simulate the Navigation bar in Pages, 
some of us have taken to displaying the View 
> Page Thumbnails bar at the left, expanded 
as large as possible (drag its right border). It 
gets large enough that you can read the text in 
its thumbnails. I like to open it to the table of 
contents pages, so I can see the ‘outline’ there, 
and sometimes I open another copy of the 
manuscript in a separate document window 
so that I can more fully view the outline or a 
second portion of a manuscript.

Unfortunately, all of these workarounds pale 
in comparison to Word’s Navigation bar and, 
frankly, the quality of the link-based user 
navigation in the Take Control series has de-
creased slightly because of this, because it is 
so much more difficult for authors and editors 
to determine where a possible link might lead.

Find the documentation
Another classic strategy for learning a pro-
gram deeply is to read the manual or some 
other form of documentation. I have read 
the entire Pages manual, and I found it frus-
trating because while it does document how 
Pages is supposed to operate, it doesn’t clarify 
which features that you might expect in a 
word processor are not present. (To be fair, 
very few programs document their shortcom-
ings.) Also, I’ve found some features to be a 
bit dodgy, most notably section breaks and 
style modifications, and I can’t figure out if 
it’s me or a bug in Pages; the manual doesn’t 
provide examples or describe common use 
cases.

You can find the manual by choosing Pages 
> Help, but if you plan to refer to it often, I 
suggest downloading the PDF and storing it 
somewhere handy: <manuals.info.ap-
ple.com/en_US/Pages09_UserGuide.
pdf>.

A useful resource for ebook publishers is a 
short document published by Apple called 
‘ePub Best Practices for Pages’,which you can 
download from a link in the Apple support 
note ‘Creating ePub files with Pages’. The 
document mentions the handful of styles that 
you need to use in a Pages document slated 
for EPUB export and notes the all-important 
fact that graphics in such a document must be 
inline, not floating: <support.apple.com/
kb/HT4168>.

It took time to learn that the best way to place 
a figure-sized graphic as inline is to first cre-
ate a paragraph formatted so that the ‘Line’ is 
‘At Least’ a specified line height; the ‘At Least’ 
setting allows the line height to increase to 
the height of the graphic (open the Inspector, 
click the T (for Text) button, click the Text 
button). Once you have the proper line height 
format set, press Command while you drag the 
image file in from the Finder.

Another useful resource is the Pages Apple 
Support Community, which I’ve visited sever-
al times to ask questions and to try to help out 
by answering a few. If you have Pages ques-
tions, this is a good place to ask: <discus-
sions.apple.com/community/iwork/
pages?categoryID=225>.

http://manuals.info.apple.com/en_US/Pages09_UserGuide.pdf
http://manuals.info.apple.com/en_US/Pages09_UserGuide.pdf
http://manuals.info.apple.com/en_US/Pages09_UserGuide.pdf
http://support.apple.com/kb/HT4168
http://support.apple.com/kb/HT4168
http://discussions.apple.com/community/iwork/pages?categoryID=225
http://discussions.apple.com/community/iwork/pages?categoryID=225
http://discussions.apple.com/community/iwork/pages?categoryID=225
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Work with great people
Although it was fairly easy to write this ar-
ticle, it was not easy to learn everything that 
I’ve mentioned in it. It would have been all 
the harder had I not been part of a small 
working group of smart and good-spirited 
people who could commiserate with my woes 
and sometimes point out options that I’d 
overlooked.

I could write a great deal more about the fine 
points of Pages and working with change 
tracking, about how I had to make a macro in 
order to insert a comment without the time-
stamp being pre-highlighted (such that when 
you start typing the timestamp disappears, 
unless the first key you press is the Right ar-
row key), about Pages versus Word templates, 
and more, but I have covered the main high 
(and low) points for now. If you have a Pages 
tip to share, please let us know in the com-
ments.

There is always space in AppleSauce
for your contribution



February 2012AppleSauce Page 12Contents

Musings...
Expectations, AirPrint, iTunes Match...

The view from BC
Spoiler

Working at your Mac (doesn’t matter 
what you’re in: web-page, text doc)? 

Want some excitement? Just press Control-
Option-Command-8 for Fun and Profit...

Great expectations?
Well, it’s early-to-mid January as I’m writ-
ing this, and very little in the high tech world 
seems to have happened so far this year. Oh! 
the big Consumer Electronics Show began 
in Las Vegas today; as per Divine Right, 
the CEO of Microsoft gave the keynote ad-
dress: <www.appleinsider.com/arti-
cles/12/01/09/ces_live_report_on_
the_steve_ballmer_keynote.html>. 
(Just as Apple dropped out of Macworld Expo 
a few years ago, Microsoft says this may be 
the last CES at which they will be exhibiting 
and giving the keynote speech.)

Many PC makers seem to be very hotly trot-
ting out ‘UltraBooks’, skinny laptops as close 
as they can get to a MacBook Air. Sales suc-
cess could be problematical for the fair num-
ber who are having mucho trouble getting 
cost of manufacture of these beasties down 
as low as Apple does for its Air. (And if you 
listen carefully, you might still hear the very 

Mike Millard
And, yes, Virginia, an ‘iPhone 5’ might actu-
ally appear late this year (around the time 
that new iPhones have been traditionally 
introduced).

AirPrint
When Apple introduced the 
iPad two years ago, the term 
‘AirPrint’ appeared, a way 
of printing from an iDevice 
to certain classes of printer. 
Ever since, I don’t think I 
have heard much at all about it from Apple 
itself, but app developers and printer makers 
have subsequently done quite a lot to provide 
the promised functionality. (‘Printing’ to me 
meant being able to print from a Pages docu-
ment on my iPad to A4 stationery, or a picture 
in the iPad to photographic paper.)

I’m not aware of printing being possible from 
an iDevice to a printer connected directly 
to that device. Everything I’ve seen involves 
printout travelling via WiFi from the iDevice 
to a printer on a network in some way.

One method allows you to print to a printer 
connected to a Mac or PC that is ‘shared’ to 
other devices; an active app — e.g. Printopia —
on the Mac/PC handles printout from the 

Apple

faint sound of the occasional netbook, the Big 
Thing from these outfits so recently...)

For weeks, the furphies have been flying that 
an ‘iPad 3’ will be out Real Soon Now: some 
suggest it might be announced on 24 Febru-
ary, Steve Jobs’ birthday. (One outfit, not 
known for consistent accuracy in rumour-
mongering, said to expect an ‘iPad 4’ late this 
year. That story got honked at very roundly!) 
Features such as a ‘retina’ screen — à la 
iPhone 4S — and better cameras are touted.

Some are wondering ‘whither the Mac Pro, 
Apple’s legacy-styled tower. Apparently not 
so many of them are sold these days, mean-
ing that they don’t contribute a heck of a 
lot to the Mother Corp’s profits. They could 
be upgraded, or the whole line dropped. Of 
course, there are some users for whom this 
style of machine is an obvious necessity, but 
for many, a revved-up 27-inch iMac with mul-
tiple drives connected by Thunderbolt and a 
second Thunderbolt Apple Display would do 
very nicely.

http://www.appleinsider.com/articles/12/01/09/ces_live_report_on_the_steve_ballmer_keynote.html
http://www.appleinsider.com/articles/12/01/09/ces_live_report_on_the_steve_ballmer_keynote.html
http://www.appleinsider.com/articles/12/01/09/ces_live_report_on_the_steve_ballmer_keynote.html
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The view from BC

board on your screen. You can type Stickies-
like notes (but with no choice of font, style or 
point size!), draw freehand in three colours 
and erase.

There is a bit more detail (though not much!) 
at <imaginaryroots.co.uk/doo-
dledesk>, but it is easy to use…

Gmail hacked!
There is a rather sombre story in the Atlantic 
Magazine by someone who had their Gmail 
account tampered with. This lengthy article 
is at <www.theatlantic.com/magazine/
archive/2011/11/hacked/8673>.

In closing
Please drop me a line if you have any com-
ments or questions on this article: <mike.
millard@shaw.ca>. Thanks.

iDevice. Other devices, particularly ‘All-in-
One’ scanner/printers, communicate WiFi-ly. 
This latter bunch finally provides ‘AirPrinting’ 
as Apple intended. (Note: these are currently 
very recent models. If their specs do not men-
tion AirPrint they likely cannot do it. Canon, 
HP, Epson and Kodak all make such AirPrint-
compatible models, and all publish free iOS 
apps for printing photos directly to their 
respective WiFi-equipped models.)

iTunes Match
Apple finally implemented iTunes Match in 
several countries. For an annual fee of $34.99 
Apple will maintain your complete iTunes 
library (that you maintain on, say, your main 
computer) ‘in the [i]Cloud’ so you can play 
this music on ‘any and all’ of your iDevices. 
(See <www.apple.com/au/icloud/fea-
tures> and scroll down a bit to iTunes 
Match.)

Where have the contents of your iTunes 
library on your computer come from? I’d say 
it will be material you have ‘ripped’ yourself 

from CDs, what you have purchased from the 
iTunes Store, and other things you may have 
downloaded or copied. So... how does iTunes 
Match handle each of these?

It starts by scanning the iTunes library: which 
could take a while :-). If anything it finds in 
your library ‘matches’ something in Apple’s 
repository, it puts a reference to a ‘best qual-
ity’ version of it (256k bit rate) in your iCloud. 
Only if there is no match will it actually copy 
the track(s) up to your iCloud. Once every-
thing is ‘matched up’, you can play stuff from 
the iCloud * or ask for a copy to be actually 
downloaded to the iDevice.

For one person’s experience of ‘matching’, 
see the TidBITS article by Matt Neuberg at 
<tidbits.com/article/12702>.

DoodleDesk
This is a new ‘white-board’ app for Mac OS X 
(10.7). It is ‘$5.99’ from the Mac App Store. 
(That’s what it cost me from the Canadian 
Mac App Store; I can’t get to the Aus App 
Store to see what they are charging for it.) 
This tiny app creates a ‘full screen’ white-

* To play directly from your iCloud, your iDevice must 
be connected to the Internet (by WiFi is cheaper 
than by 3G!).

Apple

http://imaginaryroots.co.uk/doodledesk/
http://imaginaryroots.co.uk/doodledesk/
http://www.theatlantic.com/magazine/archive/2011/11/hacked/8673/
http://www.theatlantic.com/magazine/archive/2011/11/hacked/8673/
http://www.apple.com/au/icloud/features/
http://www.apple.com/au/icloud/features/
http://tidbits.com/article/12702
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Links...
URLs, URLs, and more URLs

The Web page
Many are the schemes devised to protect 

intellectual property, including copy-
right law, copy protection on software distri-
bution, DVD zones, DRM... What comes next? 
In a recent piece on BoingBoing, ‘The coming 
war on general-purpose computing’, Cory 
Doctorow has some words of warning: <bo-
ingboing.net/2012/01/10/lockdown.
html>.

Looking back at an earlier age is ‘The Re-
start Page’ at <www.therestartpage.
com>. “Do you long for the days when your 
Mac would start with a smiling Mac logo 
and a row of INITs along the bottom of the 
screen? Or perhaps you miss watching a 
NeXT machine perform its initial memory 
scan? Pine no more for the past, because The 
Restart Page will transport you there.”

Not just Macs, but Apple IIgs, PCs, Atari and 
others.

there’s more at <blogs.plos.org/neu-
rotribes/2011/11/22/the-sketch-
book-of-susan-kare-the-artist-
who-gave-computing-a-human-face>.

Unix predates the Mac, and in the form 
of OS X is the Mac’s foundation. There’s an 
account of the early days at <spectrum.
ieee.org/computing/software/the-
strange-birth-and-long-life-of-
unix/0>. It’s written by an Australian, War-
ren Toomey, who teaches at Bond University.

How do you type ⌘, ♀, or ♳? With the 
Character Viewer, quite easily. For a tutorial, 
see <reviews.cnet.com/8301-13727_7-
57353404-263/how-to-use-the-os-x-
character-viewer>.

The Mac has a comprehensive set of key-
board shortcuts. Read about them at <sup-
port.apple.com/kb/ht1343>.

Before the days of windows, icons and 
mouse pointer devices editing had to be done 
with keyboard commands: Control-A for 
at the beginning of a line for example. Many 
of those commands are still in some Mac 
software, and still useful. Read about them 
at <reviews.cnet.com/8301-13727_7-
57343359-263/advanced-text-han-
dling-tips-in-os-x>.

On page 27 of the September 2011 Apple-
Sauce there’s a picture of an orang utang 
with an iPad. Experiments with primates and 
iPads are increasing in number, and now pigs 
are joining in, although they don’t use the 
tablets themselves. They respond to sounds 
and lights flashed on screens in the Pig Chase 
game:

‘The Playing with Pigs project is research-
ing the complex relationship we have with 

Before OS X there was Rhapsody

Also looking 
back at the early 
history of the Mac 
is a site by Susan 
Kare, who designed 
the original set 
of icons. Find it 
at <www.kare-
prints.com>, and 

http://boingboing.net/2012/01/10/lockdown.html
http://boingboing.net/2012/01/10/lockdown.html
http://boingboing.net/2012/01/10/lockdown.html
http://www.therestartpage.com/
http://www.therestartpage.com/
http://blogs.plos.org/neurotribes/2011/11/22/the-sketchbook-of-susan-kare-the-artist-who-gave-computing-a-human-face/
http://blogs.plos.org/neurotribes/2011/11/22/the-sketchbook-of-susan-kare-the-artist-who-gave-computing-a-human-face/
http://blogs.plos.org/neurotribes/2011/11/22/the-sketchbook-of-susan-kare-the-artist-who-gave-computing-a-human-face/
http://blogs.plos.org/neurotribes/2011/11/22/the-sketchbook-of-susan-kare-the-artist-who-gave-computing-a-human-face/
http://spectrum.ieee.org/computing/software/the-strange-birth-and-long-life-of-unix/0
http://spectrum.ieee.org/computing/software/the-strange-birth-and-long-life-of-unix/0
http://spectrum.ieee.org/computing/software/the-strange-birth-and-long-life-of-unix/0
http://spectrum.ieee.org/computing/software/the-strange-birth-and-long-life-of-unix/0
http://reviews.cnet.com/8301-13727_7-57353404-263/how-to-use-the-os-x-character-viewer/
http://reviews.cnet.com/8301-13727_7-57353404-263/how-to-use-the-os-x-character-viewer/
http://reviews.cnet.com/8301-13727_7-57353404-263/how-to-use-the-os-x-character-viewer/
http://support.apple.com/kb/ht1343
http://support.apple.com/kb/ht1343
http://reviews.cnet.com/8301-13727_7-57343359-263/advanced-text-handling-tips-in-os-x/
http://reviews.cnet.com/8301-13727_7-57343359-263/advanced-text-handling-tips-in-os-x/
http://reviews.cnet.com/8301-13727_7-57343359-263/advanced-text-handling-tips-in-os-x/
http://www.kareprints.com/
http://www.kareprints.com/
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The Web page

domesticated pigs by designing a game. 
Designing new forms of human-pig in-
teraction can create the opportunity for 
consumers and pigs to forge new relations 
as well as to experience the cognitive ca-
pabilities of each other. The game is called 
Pig Chase.’

Read about it at <www.playingwithpigs.
nl>.

Cats are also known to play with iPads, 
but GirlieMac has combined cats and 
HTTP status messages. ‘Error 404: file 
not found’ will never be the same again: 
<www.flickr.com/photos/girliemac/
sets/72157628409467125>.

Apple designs have long influenced other 
manufacturers, but perhaps not this way 
before: a compact with mirror that looks like 
a tiny MacBook Air. See it at: <www.bemle-
gaus.com/2011/11/macbook-zinho-
air.html>.

Nearly time for the annual 
celebration: <darwinday.org>

What happened with the Internet in 2011? 
Lots of numbers at <royal.pingdom.
com/2012/01/17/internet-2011-in-
numbers>.

How can you select a whole paragraph 
at once? Find out at <reviews.cnet.
com/8301-13727_7-57339714-263/
text-handling-tips-in-os-x>.

http://www.playingwithpigs.nl/
http://www.playingwithpigs.nl/
http://www.flickr.com/photos/girliemac/sets/72157628409467125/
http://www.flickr.com/photos/girliemac/sets/72157628409467125/
http://www.bemlegaus.com/2011/11/macbook-zinho-air.html
http://www.bemlegaus.com/2011/11/macbook-zinho-air.html
http://www.bemlegaus.com/2011/11/macbook-zinho-air.html
http://darwinday.org/
http://royal.pingdom.com/2012/01/17/internet-2011-in-numbers/
http://royal.pingdom.com/2012/01/17/internet-2011-in-numbers/
http://royal.pingdom.com/2012/01/17/internet-2011-in-numbers/
http://reviews.cnet.com/8301-13727_7-57339714-263/text-handling-tips-in-os-x/
http://reviews.cnet.com/8301-13727_7-57339714-263/text-handling-tips-in-os-x/
http://reviews.cnet.com/8301-13727_7-57339714-263/text-handling-tips-in-os-x/
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Computing at 
Entropy House

Incoherent comment...

Computing at

Boltzmann’s formula for the entropy of a 
macroscopic system of particles: entropy 

S is proportional to the logarithm of the 
number N of microscopic states consistent 
with that macroscopic state. The constant kB 
is there to get the units right.

This was the subject of one of Chad Orzel’s 
pre-Newton’s birthday series of ‘Uncertain 
Principles’ blog items. He writes:

This equation, then, really captures the 
central notion of the entire field. The 
macroscopic property known as entropy is 
just a measure of how many microscopic 
arrangements of particles and states could 
give you the same collection of properties 
for the macroscopic system. If there are 
lots of ways to get basically the same situ-
ation, the entropy is high; if there are only 
a few ways of getting a particular set of 
properties, then it has low entropy.

Read the whole thing at <scienceblogs.
com/principles/2011/12/the_ad-
vent_calendar_of_physics_17.php>.

Someone asked “Should it be ‘mouses’ or 
‘mice’?” Among the replies was a contrived 
acronym with no basis in fact. In reality, the 
name came about simply because the device 
looked to its makers, Douglas Engelbart and 
Bill English, like a mouse, with the cable as 
tail.

The Apple Publications Style Guide (Septem-
ber 2008) has this to say (p 119):

mouse Drop references to the mouse as 
quickly as possible. Switch emphasis to 
the actions on the screen, such as click-
ing, dragging, selecting, or choosing. See 
also choose; click; drag; press; select 
(v.).

Avoid using the plural form of mouse. If 
you must use the plural, use either mouse 
devices or mice.

Apple offers several types of mouse 
devices.

While we’re looking at Apple’s style guide, 
here’s what it says about a certain key (p 18):

Apple key Don’t use. The key with the 
Apple logo is the Command key. See also 
Command key.

Which is described on p 41:

Command key On first use in print user 
documentation, identify the Command 
key with its symbol: Command (⌘) key. 
Thereafter, just use Command key. Don’t 
use Apple key. It’s OK to use the Com-
mand key symbol in a list of shortcuts.

⌘-Option-Escape

⌘-Shift-Option-Delete

Colleague at organisation R was work-
ing on a document and found that when he 
added to an existing line of text it indented. 
The same happened with the next paragraph. 

The first computer mouse, in Douglas 
Engelbart’s hand

http://scienceblogs.com/principles/2011/12/the_advent_calendar_of_physics_17.php
http://scienceblogs.com/principles/2011/12/the_advent_calendar_of_physics_17.php
http://scienceblogs.com/principles/2011/12/the_advent_calendar_of_physics_17.php
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Computing at Entropy House

The Command key symbol in its earlier 
setting, as a marker for an interesting 
or historical site
His ad hoc solution to the problem was to 
hit Enter in a couple of places so that each 
line of the text was a separate paragraph and 
therefore began against the margin.

Took a copy of the document to investigate. 
Sure enough, a confused mess of manual 
formatting imposed on several styles in a 
template from somewhere else. Tidied things 
up, defined some new styles and made a new 

template, with strict instructions to use its 
styles only, without any overrides. We’ll see.

Same organisation needed some new 
emergency evacuation diagrams to replace 
some outdated hand-drawn ones. Set to work 
with Illustrator. All fairly mundane stuff, 
rectangles and lines with text here and there. 
Someone who hadn’t seen Illustrator before 
thought it was ‘brilliant’. Well, anything is 
brilliant compared to Word...

Unlike InDesign with character, paragraph 
and object styles, Illustrator has an eyedrop-
per that can copy stroke, fill, colour and text 
characteristics from one object to another. 
Trick is to set up sample objects and copy 
characteristics as required. (InDesign can 
do that too, but using styles is the better 
scheme.) There other inconsistencies between 
the two.

Colleague wanted to look at some video 
on his PC laptop, but kept getting error mes-
sages about Flash. He installed the latest 
version, to no avail. Adobe’s help site wasn’t 
much help (surprise), and neither were most 
other forums and other sites. Eventually he 
came across advice to disable ActiveX if run-
ning under Windows Vista. He did that, and 
Flash worked.

We’re not missing anything: HTML5 and 
H.264 every time.

Emergency 
lighting Smoke detector

CO2

Water Dry powder

Fire blanket

Emergency evacuation symbols: 
couple of minutes each with Illustrator

Colour panel in InDesign: click the 
 to swap fill and stroke colours

The corresponding Illustrator 
panel: drag fill to stroke or vice 
versa. Why the difference?
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Computing at Entropy House

Look closely: this is not a picture 
of Steve Jobs but an action figure 
by a toy company. It may or may 
not be made in quantity but you 
can read about it at <thenextweb.
com/apple/2012/01/02/this-steve-
jobs-action-figure-is-so-realistic-its-
actually-kind-of-freaky>

At least I don’t have
to be involved

SJ Gould would not approve. (See 
Wonderful Life, pp 27 – 45)

The mouse evolves: the Evoluent 
VerticalMouse is designed to 
reduce stress on the forearm by 
keeping it in a more natural and 
relaxed position. Details are at 
<www.evoluent.com>.

http://thenextweb.com/apple/2012/01/02/this-steve-jobs-action-figure-is-so-realistic-its-actually-kind-of-freaky/
http://thenextweb.com/apple/2012/01/02/this-steve-jobs-action-figure-is-so-realistic-its-actually-kind-of-freaky/
http://thenextweb.com/apple/2012/01/02/this-steve-jobs-action-figure-is-so-realistic-its-actually-kind-of-freaky/
http://thenextweb.com/apple/2012/01/02/this-steve-jobs-action-figure-is-so-realistic-its-actually-kind-of-freaky/
http://www.evoluent.com/
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AppleSauce
AppleSauce is the official organ of SAAUC Inc., and is published eleven times 
per year, February – December.

AppleSauce is an independent production and has not been authorised, 
sponsored or otherwise approved by Apple Computer Inc.

Opinions expressed in AppleSauce may not be those of SAAUC or its officers.

Guidelines for Contributors
Articles and artwork on any topic relating to Apple computers are welcomed. 
E-mail to the Editor <pcarter@acslink.net.au>, or post to the Editor’s 
business address (Pelagos Productions, PO Box 133 Brooklyn Park 5032).
Deadline is the third Friday of the preceding month.

Submissions must be spell checked, in ASCII text format (.txt, not Word 
(.doc or .docx), Pages or AppleWorks), with graphics as separate files. Text and 
images may be combined in a ZIP archive. (If in doubt, please ask.)
The Editor reserves the right to edit as required: authors will be contacted if 
major surgery is necessary.

Advertising
Small advertisements from financial members will be accepted and published free of 
charge, provided they are signed by the person(s) placing the advertisement.
Business advertising rate is $50.00 per page (or by negotiation) with submission as 
PDF file. Page size is A4 landscape (842 * 595 pixels), and commercial advertising 
deadline is the second Friday of the month.
Advertisements must not conflict with the interests of the club. Publication does not 
imply recommendation or endorsement by SAAUC Inc.

Copyright
Except where otherwise stated, this publication is copyright © 2012 by SAAUC Inc. 
Authors and advertisers express their own opinions and are responsible for the 
accuracy of their submissions.
Permission is granted for the reproduction of original articles contained in this issue 
by any non-profit organisation provided the author, title and publication credits are 
given, and a copy of the publication is sent to SAAUC. Contact the editor for text and 
graphics files.

AppleSauce is prepared with BBEdit from Bare Bones Software, and Adobe InDesign, Photoshop, Illustrator, 
and Acrobat Professional. Folder navigation is aided by Default Folder from St Clair Software, Web site 
maintenance by Fetch from Fetch Software

Directory 2011 – 2012
President: Grant Ward

Vice President: Peter Wiechmann

Secretary: Judith Watts

Treasurer: Susan Harrap

Editor: Peter Carter

2011 Committee: Barrie Coppock, Mike Summers

To contact SAAUC: <info@saauc.org.au> 
PO Box 411 Glenside SA 5065 
NodePhone (08) 7127 1000

Web site: <www.saauc.org.au>

‘The fine print...’
South Australian Apple Users’ Club Inc

Meetings
Two meetings are held each month, except January, at 
the Salvation Army Centre, Marion Street Unley.

The Friday meetings are on the first Friday of the 
month, commencing at 7:30 pm, with the library and 
update machine available. Meetings normally alternate 
between presentations and special interest groups 
(SIGs).

Wednesday meetings are normally the following 
Wednesday, and do not have a set format.

For more detail, see the Web site Meetings and 
Calendar pages.

Directory references

Fullers: Map 52 C2

Gregory: Map 200 E5

UBD: Map 130 K5

Zone 54H grid: 

02816 61301

Latitude and Longitude: 

34° 66' 52.9" S 

138° 36' 31.2" E

NU
nley Road

Whittam St

Culvert St

Maud St

Marion St

Frederick St

Oxford Tce
Arthur St

Mary St

Charles St

Hughes St

http://www.saauc.org.au/
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